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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 9470m Notebook PC

Processors Intel® Core® processors:

● i3-3217U 1.8-GHz, 3-MB L3 Cache, 17W

● i5-3317U 1.7-GHz (max turbo frequency 2.6-GHz), 3-MB L3 Cache,
17W

● i5-3427U 1.7-GHz (max turbo frequency 2.7-GHz), 3-MB L3 Cache,
17W

● i7-3667U 1.8-GHz (max turbo frequency 2.9-GHz), 4-MB L3 Cache,
17W

Chipset Mobile Intel QM77

Graphics Intel UMA Graphics with shared video memory: Intel HD Graphics 4000

Panels 35.6-cm (14.0-in), 3.0-mm, flat/thin backlit, light-emitting diode (LED), high-
definition+ (HD+), AntiGlare (AG), SVA (1600×900) display with and without
webcam

35.6-cm (14.0-in), 3.0-mm, flat/thin backlit, LED, HD, AG, SVA (1366×768)
display with and without webcam

All display assemblies include two wireless local area network (WLAN) antenna
cables and two wireless wide area network (WWAN) antenna cables

Supports low voltage differential signalling (LVDS)

Supports 16:9 aspect ratio

Supports privacy filter
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Category Description

Memory Two customer-accessible/upgradable memory module slots

DDR3 PC3-1600-MHz dual channel support

Supports 16384-MB of system RAM in the following configurations:

● 16384-MB (8192-MB×2)

● 8192-MB (8192-MB×1 or 4096×2)

● 6144-MB (4096-MB+2048-MB)

● 4096-MB (4096-MB×1 or 2048-MB×2)

● 2048-MB (2048×1)

Flash cache Samsung 32-GB MLC mSATA module, not available on computer models
equipped with SSD, SED, or 256 mSATA.

Supports no Flash cache module configuration.

Hard drive Supports 7.0-mm (.28-in), 6.35-cm (2.5-in) hard drives and solid-state drives

Customer-accessible

Serial ATA

Supports the following hard drives:

● 500-GB, 7200-rpm, self-encrypting drive (SED)

● 500-GB, 7200-rpm

● 320-GB, 7200-rpm

Solid-state drive Solid-state drive (SSD) mounts in the same bracket as the hard drive

Customer-accessible

Serial ATA III

Supports the following SSDs:

● 256-GB SED

● 180-GB

mSATA module Supports 256-GB mSATA module

No available with flash cache module

Audio and video Two stereo speakers

 HD audio with SRS PRO audio

 Integrated 720p HD webcam (supports no camera option)

 Integrated dual-array microphone
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Category Description

Ethernet Intel 82579LM 10/100/1000 Ethernet network interface card (NIC) with
iAMT Intel 82579LM Gigabit Network Connection

NIC Power Down technology

S3/S4/S5 wake on LAN

Ethernet cable not included

Wireless Integrated wireless local area network (WLAN) options by way of
wireless module

Three WLAN antennas built into display assembly

Support for the following WLAN formats:

● QC/Atheros AR9462 802.11a/b/g/n 2x2 BT4.0 combo

● Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0
Combo Adapter

● Intel Centrino Advanced-N 6235

● Intel Centrino Advanced-N 6205 WLAN module

Supports no WLAN option

 Integrated wireless wide area network (WWAN) options by way of
wireless module

Two world-wide/5-band WWAN antennas built into display assembly

Secured by subscriber identity module (SIM, user-accessible behind battery)

Support for the following WWAN formats:

● HP lt2523 LTE/HSPA+ Mobile Broadband Module

● HP lt2522 LTE/EV-DO Mobile Broadband Module

● HP un2430 EV-DO/HSPA Mobile Broadband Module

● HP hs2350 HSPA+ Mobile Broadband Module

Supports no WWAN option

Supports WWAN after market option

External media cards Integrated 54-mm ExpressCard

Secure Digital (SD) flash media slot with push-push technology, supporting the
following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC
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Category Description

Ports Audio-in (mono microphone)

Audio-out (stereo headphone)

Battery connector

DisplayPort 1.1a

Docking connector

HP Smart AC adapter

RJ-45 (Ethernet)

USB 3.0 ports (2)

USB 3.0 charging/powered port (1)

VGA (Dsub 15 pin) supporting: 1920×1200 external resolution @ 75 Hz, hot
plug and unplug and autodetection for correct output to wide-aspect vs.
standard aspect video

Keyboard/pointing devices Full chiclet keyboard, backlit, dual-point, spill-resistant with durakeys

 Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-
zoom as default

 Taps enabled by default

 Touchpad on/off button

 Touchpad supports 2-way scroll with legend

Power requirements Supports the following HP Smart AC adapters:

 45-W HP Smart AC adapter (3-wire plug with ground pin)

 Supports the following batteries:

● Primary: 4-cell, 52-Wh, 3.55-Ah battery

● Secondary: 6-cell, 60-Wh, 2.7-Ah battery

Security Supports security cable lock

 Supports fingerprint reader and no fingerprint reader option

 Supports Trusted Platform Module (TPM) 1.2 (Infineon, soldered down) and
TPM Enhanced Drive Lock (not supported the People's Republic of China)

 Integrated Smart Card reader (active)

 Full volume encryption

 HP ProtectTools
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Category Description

Operating system Preinstalled:

● Windows® 7 Home Premium 64- and 32-bit with Microsoft Basics (in
Canada, Japan, and the United States)

● Windows 7 Professional 64- and 32-bit with Microsoft Basics (in Canada,
Japan, and the United States)

● Windows 8 Professional 64 with Windows 7 Professional 32 or 64 image
and with Microsoft Basics (in Canada, Japan, and the United States)

● Windows 8 Professional 64 with Microsoft Basics (in Canada, Japan, and
the United States)

● Windows 8 64 with Microsoft Basics (in Canada, Japan, and the
United States)

● Windows 8 64 with Microsoft Basics (in the People's Republic of China)

● FreeDOS

● SUSE Linux SLED (for China only)

5



Category Description

 Preinstalled with Microsoft Office

Windows 7:

● Windows 7 Home Basic 32-bit with Office Transition (emerging markets
only, not available in Japan)

● Windows 7 Home Premium 64- and 32-bit with Office Transition (not
available in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Personal (only
in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Home and Business
(only in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Professional (only
in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Transition (not
available in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Home and
Business (only in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Personal (only
in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Professional
(only in Japan)

Windows 8

● Windows 8 Professional 64 with Windows 7 Professional 64- and 32
Image with Office 2010 Transition (not available in Japan)

● Windows 8 Professional 64 with Windows 7 Professional 64- and 32
Image with Office 2010 Personal (only in Japan)

● Windows 8 Professional 64 with Windows 7 Professional 64- and 32
Image with Office 2010 Home and Business (only in Japan)

● Windows 8 Professional 64 with Windows 7 Professional 64- and 32
Image with Office 2010 Professional (only in Japan)

● Windows 8 Professional 64 Office 2010 Transition (not available
in Japan)

● Windows 8 Professional 64 Office 2010 Personal (only in Japan)

● Windows 8 Professional 64 Office 2010 Home and Business (only
in Japan)

● Windows 8 Professional 64 Office 2010 Professional (only in Japan)

● Windows 8 64 Office 2010 Transition (not available in Japan)

● Windows 8 64 Office 2010 Personal (only in Japan)

● Windows 8 64 Office 2010 Home and Business (only in Japan)

● Windows 8 64 Office 2010 Professional (only in Japan)

● Windows 8 64 Office 2010 Transition (emerging markets only, not
available in Japan)6 Chapter 1   Product description



Category Description

 Restore media–DR-DVD:

● Windows 7 without Windows DVD

● Windows 7 with Windows DVD

● Windows 8

 Restore media–OS-DVD:

● Windows 7 Home Basic 32-bit

● Windows 7 Home Premium 64- and 32-bit

● Windows 7 Professional 64- and 32-bit

 Certified:

● SuSE Linux 64-bit Service Pack 2

 Web-only support:

● Windows XP Pro 32-bit

● Windows 7 Home Basic 64-bit

● Windows 7 Enterprise 64- and 32-bit

● Windows 7 Ultimate 64- and 32-bit

Serviceability End user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Solid-state drive

● Keyboard

● Memory module

● mSATA flash cache

● WLAN module

● WWAN module
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2 External component identification

Display

Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(2) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide area networks (WWAN).

(3) Internal microphones (2) Record sound.

(4) Webcam light (select models only) On: The webcam is in use.
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Component Description

(5) Webcam (select models only) Records video and captures still photographs.

To use the webcam in Windows 7, select Start > All
Programs > HP > HP Webcam.

For information on using the webcam in Windows 8, access Help
and Support. From the Start screen, type help, and then select
Help and Support from the list of apps.

For information on using the webcam, access Help and Support.
From the Start screen, type help, and then select Help and
Support from the list of apps.

(6) Internal display switch Turns off the display or initiates Sleep if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. In Windows 7, these notices are located in Help and Support. In
Windows 8, to access this guide, select the HP Support Assistant app from the Start screen, select My computer, and
then select User guides.

Top

TouchPad

NOTE: Windows 8 keyboard shown.
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Component Description

(1)  Pointing stick Moves the pointer and selects or activates items on the
screen.

(2)  Left pointing stick button Functions like the left button on an external mouse.

(3)  TouchPad on/off button Turns the TouchPad on and off.

(4)  TouchPad zone Moves the pointer and selects or activates items on the
screen.

(5)  Left TouchPad button Functions like the left button on an external mouse.

(6)  Right pointing stick button Functions like the right button on an external mouse.

(7)  Right TouchPad button Functions like the right button on an external mouse.
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Lights

NOTE: Windows 7 keyboard shown.

Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(2) Microphone mute light ● On: Microphone is off.

● Amber: Microphone is on.

(3)  Num lock light On: Num lock is on.

(4) Wireless light ● White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a
Bluetooth® device, is on.

● Amber: All wireless devices are off.

(5) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(6)  Caps lock light On: Caps lock is on.

(7)  TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.
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Buttons and fingerprint reader (select models only)

NOTE: Windows 8 keyboard shown.
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Component Description

(1) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button briefly to
initiate Sleep/Suspend.

● When the computer is in the Sleep/Suspend state, press
the button briefly to exit Sleep/Suspend.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and hold
the power button for at least 5 seconds to turn off the
computer.

To learn more about your power settings:

In Windows 7:

● Select Start > Control Panel > System and
Security > Power Options.

In Windows 8:

● See your power options. From the Start screen, type
power, select Settings, and then select Power
Options.

In SUSE Linux:

1. Select Computer > Control Center.

2. In the left pane, click System, and then click Power
Management in the right pane.

(2) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

(3) Volume mute button Mutes and restores speaker sound.

(4)  Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a
password logon.
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Keys – Windows models

Component Description

(1)  esc key Displays system information when pressed in combination
with the fn key.

(2)  fn key Executes frequently used system functions when pressed in
combination with a function key, the num lk key, or the esc
key.

(3) Windows 7 logo key Windows 7: Displays the Windows Start menu.

Windows 8: Returns you to the Start screen from an open
app or the Desktop.

NOTE: Pressing the Windows logo key again will return
you to the previous screen.

Windows 8 logo key

(4)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5)  Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

Each key on the keypad performs the function indicated by
the icon in the upper-right corner of the key.

(6) Windows 7 applications key

Windows 8 applications key

Windows 7:Displays a shortcut menu for items beneath the
cursor.

Windows 8: Displays options for a selected object.

  

(7)  num lk key Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.
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Keys – SUSE Linux models

Component Description

(1)  fn key Executes frequently used system functions when pressed in
combination with a function key.

(2)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.

Each key on the keypad performs the function indicated by
the icon in the upper-right corner of the key.

(3)  Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

(4)  num lk key Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.
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Front

Component Description

(1) Wireless light ● White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/
or a Bluetooth® device, is on.

● Amber: All wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep/Suspend
state.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: The computer is connected to external
power and the battery is charged from 0 to 90
percent.

● White: The computer is connected to external
power and the battery is charged from 90 to 99
percent.

● Blinking amber: A battery that is the only
available power source has reached a low battery
level. When the battery reaches a critical battery
level, the battery light begins blinking rapidly.

● Off: The battery is fully charged.

(4) Hard drive light ● Blinking white: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily
parked the hard drive.
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Left

Component Description

(1) Power connector Connects an AC adapter.

(2)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(3) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(4) USB 3.0/USB charging port Connects an optional USB device. The USB charging port
can also charge select models of cell phones and MP3
players, even when the computer is off.

(5) Audio-out (headphone) jack/Audio-in
(microphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, earbuds, a headset, or television
audio. Also connects an optional headset microphone.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety, and Environmental Notices. To access
this guide in Windows 8, select the HP Support
Assistant app from the Start screen, select My computer,
and then select User guides.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and
audio-in (microphone).

(6)  Smart card reader Supports optional Smart cards.
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Right

Component Description

(1) USB 3.0 ports (2) Connect optional USB devices.

(2) DisplayPort Connects an optional digital display device, such as a high-
performance monitor or projector.

(3)  Media Card Reader Supports the following digital card formats:

● MultiMediaCard (MMC)

● MultiMediaCardplus (MMC+)

● Secure Digital (SD) Card

● Secure Digital High Capacity (SDHC) Card

● Secure Digital Extra Capacity (SDXC) Card

(4) External monitor port Connects an external VGA monitor or projector.

(5)  Docking connector Connects an optional docking device

(6) RJ-45 (network) jack Connects a network cable.

18 Chapter 2   External component identification



Bottom

Component Description

(1)  Wireless and memory module
compartment

Contains the wireless and memory modules.

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless
module authorized for use in the computer by the
governmental agency that regulates wireless devices in
your country or region. If you replace the module and
then receive a warning message, remove the module to
restore computer functionality, and then contact support
through Help and Support. In Windows 8, from the
Start screen, type help, and then select Help and
Support.

(2)  Travel battery connector Connects an optional travel battery.

(3)  Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(4)  Speakers (2) Produce sound.

NOTE: In Windows 8, to use the SRS Premium Sound
software, from the Start screen, type SRS, and then
select SRS Premium Sound from the list of apps.

(5)  Hard drive bay Contains the hard drive.
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Component Description

(6) Battery release latch Releases the battery from the battery bay.

(7)  Battery bay and SIM slot

NOTE: SIM slot on select models only.

Contains the battery. Supports a wireless subscriber
identity module (SIM). The SIM slot is located inside the
battery bay on the right side.
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3 Illustrated parts catalog

Service tag and PCID label

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

● Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.

● Model description (select models only) (5). This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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PCID label

The PCID label provides the information required to properly reset the notebook firmware (BIOS) back
to factory shipped specifications when replacing the system board. The label may have a different
number of characters depending on the operating system on the computer.

Windows 8 models

Non-Windows 8 models
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Computer major components
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 27.

(2) Keyboard (backlit; includes keyboard cable and pointing stick cable):

NOTE: For a detailed list of available keyboards, see Sequential part number listing
on page 31.

702843-xx1

(3) Top cover 

 With fingerprint reader board 702851-001

 Without fingerprint reader board 702852-001

 Touchpad assembly (not illustrated) 702856-001

(4) Speakers (right and left; include cables) 702869-001

(5) AC power connector 702875-001

(6) Smart Card reader (includes cable) 702844-001

(7) Fan (includes cable) 702859-001

(8) System board (includes processor and replacement thermal material):

 For use in models without Windows 8:  

 ● Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB
cache)

702848-001

 ● Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB
cache)

702849-001

 ● Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB
cache)

704439-001

 ● Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) 702847-001

 For use in Windows 8 models:  

 ● Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB
cache) for use in models with Windows 8 Standard

702848-501

 ● Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB
cache) for use in models with Windows 8 Professional

702848-601

 ● Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Standard

702849-501

 ● Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Professional

702849-601

 ● Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Standard

704439-501

 ● Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Professional

704439-601

 ● Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) for use in models with
Windows 8 Standard

702847-501
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Item Component Spare part number

 ● Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) for use in models with
Windows 8 Professional

702847-601

 Plastics Kit, includes: 702877-001

(9a) SD card insert  

(9b) Hard drive cover  

(10) Heat sink (includes replacement thermal material): 707907-001

(11) RTC battery 702853-001

(12) Fingerprint reader board (includes cable) 702845-001

(13) Base enclosure 702863-001

(14) Service cover 704441-001

(15) Memory modules (PC3-12800, 1666-MHz, DDR3):

 8-GB 634091-001

 4-GB 641369-001

 2-GB 652972-001

(16) WLAN module:

 Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo
Adapter

657325-001

 Intel Centrino Advanced-N 6235 670292-001

 Intel Centrino Advanced-N 6205 631954-001

 QC/Atheros AR9462 802.11a/b/g/n 2x2 BT4.0 combo 676786-001

(17) WWAN module:

 HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

 HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001

 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

 HP hs2350 HSPA+ Mobile Broadband Module 668969-001

 HP un2430 EV-DO/HSPA Mini Card 702080-001

 HP hs2350 hspa+ Mobile Broadband Module 710788-001

 HP lt2522 LTE/EV-DO Mobile Broadband Module 710789-001

 HP lt2523 LTE/HSPA+ Mobile Broadband Module 710790-001

(18) mSATA drive:  

 256-GB mSATA drive 702866-001

 32-GB mSATA drive 702867-001

 24-GB mSATA drive 702868-001
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Item Component Spare part number

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket, connector,
and screws)

702870-001

(19) Solid-state drive (includes bracket, connector, and screws):  

 256-GB, SATA III, self-encrypting drive (SED) 702865-001

 180-GB, SATA III 702864-001

(20) Hard drive (does not include hard drive bracket, connector, or screws):

 500-GB, 7200-rpm, 7-mm self-encrypting drive 703268-001

 500-GB, 7200-rpm, 7-mm 703267-001

 320-GB, 7200-rpm, 2.5-inch 603783-001

(21) Battery (Li ion):

 4-cell, 52-Wh, 3.55-Ah 687945-001

 6-cell, 60-Wh, 2.7-Ah (travel battery; not illustrated) 696621-001
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Display assembly subcomponents
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Item Component Spare part number

(1) Display bezel:

 For use on models with a webcam 702860-001

 For use on models without a webcam 702861-001

(2) Webcam/microphone module 702854-001

 Microphone module 702873-001

 Display Hinge Kit (includes left and right display hinges and left and right hinge
covers)

702857-001

(3a) Display hinge covers (2)

(3b) Display hinges

(4) 35.6-cm (14.0-in), LED, AntiGlare display panel:

 HD+ 708771-001

 HD 702871-001

 Antenna Kit, includes: 702876-001

(5a) WWAN antenna cables and transceivers

(5b) WLAN antenna cables and transceivers

(6) Display enclosure 702858-001

 Display Panel Support Kit (includes WLAN antenna cables and transceivers,
WWAN antenna cables and transceivers, and display enclosure)

702842-001
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Mass storage devices

Item Description Spare part number

(1) Hard drive (does not include hard drive bracket or screws):

 500-GB, 7200-rpm, 7-mm SED 703268-001

 500-GB, 7200-rpm, 7-mm 703267-001

 320-GB, 7200-rpm, 9.5-mm 603783-001

 Solid-State Drive (includes drive bracket, connector, and screws):

 256-GB, SATA III, self-encrypting drive (SED) 702865-001

 180-GB, SATA III 702864-001

(2a) Solid-state drive bracket  

(2b) Solid-state drive  

(2c) Drive connector  

(3) mSATA drive:

 256-GB mSATA drive 702866-001

 32-GB mSATA drive 702867-001

 24-GB mSATA drive 702868-001

 Hard Drive Hardware Kit (not illustrated), includes: 702870-001

 Hard drive connector

 Hard drive bracket

 Hard drive bracket screws
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Miscellaneous parts

Component Spare part number

AC adapter:

45-W HP Smart AC adapter (non-PFC) 696694-001

65-W HP Smart AC adapter 609939-001

Optical mouse:

HP USB optical travel mouse 434594-001

Wireless, 2.4-GHz 656840-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

Screw Kit 702846-001

Docking station 702878-001

Cable lock docking station 575921-001

Business Slim Top Load Case 688850-001
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Sequential part number listing
CSR flag designations:

A = Mandatory

B = Optional

C = Service technician recommended

N = Non-user replaceable

Spare part
number

CSR
flag

Description

434594-001 A HP USB optical travel mouse

490371-001 A Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 A Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 A Power cord for use in Europe (3-pin, black, 1.83-m)

490371-111 A Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 A Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 A Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 A Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 A Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 A Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 A Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 A Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 A Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 A Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 A Power cord for use in India (3-pin, black, 1.83-m)

575921-001 A Cable lock docking station

603783-001 A 320-GB, 7200-rpm, 7-mm hard drive (does not include hard drive bracket, connector, or screws)

NOTE: The hard drive bracket, connectors, and screws are included in the Hard Drive Hardware Kit,
spare part number 702870-001.

609939-001 A 65-W HP Smart AC adapter

631954-001 A Intel Centrino Advanced-N 6205 WLAN module

634091-001 A 8-GB memory module (PC3, 12800, 1600-MHz)

634400-001 A HP un2430 EV-DO/HSPA Mobile Broadband Module

641369-001 A 4-GB memory module (PC3, 12800, 1600-MHz)

652972-001 A 2-GB memory module (PC3, 12800, 1600-MHz)
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Spare part
number

CSR
flag

Description

656840-001 A Wireless, 2.4-GHz mouse

657325-001 A Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

676786-001 A QC/Atheros AR9462 802.11a/b/g/n 2x2 BT4.0 combo

668969-001 A HP hs2350 HSPA+ Mobile Broadband Module

670292-001 A Intel Centrino Advanced-N 6235

675791-001 A HP lt2522 LTE/EV-DO Mobile Broadband Module

675793-001 A HP lt2523 LTE/HSPA+ Mobile Broadband Module

687945-001 A 4-cell, 52-Wh, 3.55-Ah, Li-ion battery

688850-001 A Business Slim Top Load Case

696621-001 A 6-cell, 51-Wh, 2.55-Ah, Li-ion travel battery

696694-001 A 45-W HP Smart AC adapter (non-PFC)

702080-001 A HP un2430 EV-DO/HSPA Mini Card

702842-001 N Display Panel Support Kit (includes display enclosure, WLAN antenna cables and transceivers, and
WWAN antenna cables and transceivers)

702843-001 B Keyboard with pointing stick for use in the United States (includes keyboard cable and pointing
stick cable)

702843-031 B Keyboard with pointing stick for use in the United Kingdom and Singapore (includes keyboard cable
and pointing stick cable)

702843-041 B Keyboard with pointing stick for use in Germany (includes keyboard cable and pointing stick cable)

702843-051 B Keyboard with pointing stick for use in France (includes keyboard cable and pointing stick cable)

702843-061 B Keyboard with pointing stick for use in Italy (includes keyboard cable and pointing stick cable)

702843-071 B Keyboard with pointing stick for use in Spain (includes keyboard cable and pointing stick cable)

702843-081 B Keyboard with pointing stick for use in Denmark (includes keyboard cable and pointing stick cable)

702843-091 B Keyboard with pointing stick for use in Norway (includes keyboard cable and pointing stick cable)

702843-131 B Keyboard with pointing stick for use in Portugal (includes keyboard cable and pointing stick cable)

702843-141 B Keyboard with pointing stick for use in Turkey (includes keyboard cable and pointing stick cable)

702843-151 B Keyboard for use in Greece (includes keyboard cable and pointing stick cable)

702843-161 B Keyboard with pointing stick for use in Latin America (includes keyboard cable and pointing
stick cable)

702843-171 B Keyboard with pointing stick for use in Saudi Arabia (includes keyboard cable and pointing stick cable)

702843-201 B Keyboard with pointing stick for use in Brazil (includes keyboard cable and pointing stick cable)

702843-211 B Keyboard with pointing stick for use in Hungary (includes keyboard cable and pointing stick cable)

702843-251 B Keyboard with pointing stick for use in Russia (includes keyboard cable and pointing stick cable)
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Spare part
number

CSR
flag

Description

702843-261 B Keyboard with pointing stick for use in Bulgaria (includes keyboard cable and pointing stick cable)

702843-271 B Keyboard with pointing stick for use in Romania (includes keyboard cable and pointing stick cable)

702843-281 B Keyboard with pointing stick for use in Thailand (includes keyboard cable and pointing stick cable)

702843-291 B Keyboard with pointing stick for use in Japan (includes keyboard cable and pointing stick cable)

702843-A41 B Keyboard with pointing stick for use in Belgium (includes keyboard cable and pointing stick cable)

702843-AB1 B Keyboard with pointing stick for use in Taiwan (includes keyboard cable and pointing stick cable)

702843-AD1 B Keyboard with pointing stick for use in South Korea (includes keyboard cable and pointing stick cable)

702843-B31 B Keyboard with pointing stick for use in the Netherlands (includes keyboard cable and pointing
stick cable)

702843-B71 B Keyboard with pointing stick for use in Sweden and Finland (includes keyboard cable and pointing
stick cable)

702843-BA1 B Keyboard with pointing stick for use in Slovenia (includes keyboard cable and pointing stick cable)

702843-BB1 B Keyboard with pointing stick for use in Israel (includes keyboard cable and pointing stick cable)

702843-BG1 B Keyboard with pointing stick for use in Switzerland (includes keyboard cable and pointing stick cable)

702843-D61 B Keyboard with pointing stick for use in India (includes keyboard cable and pointing stick cable)

702843-DB1 B Keyboard with pointing stick for use in Canada (includes keyboard cable and pointing stick cable)

702843-DD1 B Keyboard with pointing stick for use in Iceland (includes keyboard cable and pointing stick cable)

702843-FL1 B Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard cable and
pointing stick cable)

702843-FP1 B Keyboard with pointing stick for use in northwest Africa (includes keyboard cable and pointing
stick cable)

702844-001 N Smart Card reader (includes cable)

702845-001 N Fingerprint reader board (includes cable)

702846-001 N Screw Kit

702847-001 N System board with Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) for use in models without
Windows 8

702847-501 N System board with Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) for use in models with
Windows 8 Standard

702847-601 N System board with Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) for use in models with
Windows 8 Professional

702848-001 N System board with Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB
cache) for use in models without Windows 8

702848-501 N System board with Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB
cache) for use in models with Windows 8 Standard

702848-601 N System board with Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB
cache) for use in models with Windows 8 Professional
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Spare part
number

CSR
flag

Description

702849-001 N System board with Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB
cache) for use in models without Windows 8

702849-501 N System board with Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Standard

702849-601 N System board with Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Professional

702851-001 N Top cover with fingerprint reader board

702852-001 N Top cover without fingerprint reader board

702853-001 B RTC battery (includes cable and double-sided tape)

702854-001 N Webcam/microphone module (includes double-sided tape)

702856-001 N Touchpad assembly

702857-001 N Display Hinge Kit (includes left and right hinges and left and right hinge covers)

702858-001 N Display enclosure

702859-001 N Fan (includes cable)

702860-001 N Display bezel for use on models with a webcam

702861-001 N Display bezel for use on models without a webcam

702863-001 N Base enclosure

702864-001 A Solid-state drive, 180-GB, SATA III (includes bracket, connector, and screws)

702865-001 A Solid-state drive, 256-GB, SATA III, self-encrypting drive (SED) (includes bracket, connector, and
screws)

702866-001 A 256-GB mSATA drive

702867-001 A 32-GB mSATA drive

702868-001 A 24-GB mSATA drive

702869-001 N Speaker assembly (includes cable)

702870-001 A Hard Drive Hardware Kit (includes hard drive bracket, connector, and screws)

702871-001 N 35.6-cm (14.0-in), LED, HD, AntiGlare display panel

702873-001 N Microphone module

702875-001 A AC power connector

702876-001 N Antenna Kit (includes left and right WLAN antenna cables and transceivers and left and right
WWAN antenna cables and transceivers)

702877-001 N Plastics Kit (includes SD slot insert and hard drive cover)

702878-001 A Docking station
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Spare part
number

CSR
flag

Description

703267-001 A 500-GB, 7200-rpm, 7-mm hard drive (does not include hard drive bracket, connector, or screws)

NOTE: The hard drive bracket, connector, and screws are included in the Hard Drive Hardware Kit,
spare part number 702870-001.

703268-001 A 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket, connector, or screws)

NOTE: The hard drive bracket, connector, and screws are included in the Hard Drive Hardware Kit,
spare part number 702870-001.

704439-001 N System board with Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB
cache) for use in models without Windows 8

704439-501 N System board with Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Standard

704439-601 N System board with Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB
cache) for use in models with Windows 8 Professional

704441-001 A Service cover

707907-001 N Heat sink

708771-001 N 35.6-cm (14.0-in), LED, HD+, AntiGlare display panel

710788-001 A HP hs2350 hspa+ Mobile Broadband Module

710789-001 A HP lt2522 LTE/EV-DO Mobile Broadband Module

710790-001 A HP lt2523 LTE/HSPA+ Mobile Broadband Module
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

Make special note of each screw size and location during removal and replacement.

Battery

Description Spare part number

4-cell, 52-Wh, 3.55-Ah, Li ion battery 687945-001

6-cell, 60-Wh, 2.7-Ah, Li ion travel battery 696621-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface.

2. Slide the battery release latch (1) to release the battery.

3. Slide the battery outward (2), lift the outer edge of the battery (3), and then remove it from the
computer (3).
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When installing the battery:

1. Insert the battery connector end of the battery into the bay, aligning it to the left edge.

2. Slide the battery into the bay until it drops and the latch snaps, and then slide the latch to the left
to lock the battery.

NOTE: In the locked position there will be no red color shown in the latch slot.

SIM

NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

The SIM slot is located inside the battery bay on the right side.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Display assembly components (panel, bezel, webcam, microphone)

All display assemblies include WLAN antenna transceivers and cables. WWAN models also include 2
WWAN antenna transceivers and cables.

Full hinge-up displays are not spared.

This section describes removing components that do not require that you entirely remove the display
assembly from the computer. You can remove the display bezel, webcam/microphone module, and
display panel with the display assembly still attached to the computer.

To remove the remaining display components, including the display brackets, antennas, and enclosure,
you must remove the entire display assembly from the computer. See Display assembly on page 78
for more information about removing the remaining components.

Description Spare part number

Display panels

35.6-cm (14.0-in), HD+, anti-glare, LED 708771-001

35.6-cm (14.0-in), HD anti-glare, LED 702871-001

Display bezels  

For use with models with a webcam 702860-001

For use with models without a webcam 702861-001

Webcam module with microphone 702854-001

Microphone module 702873-001

Before removing the display panel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the display assembly components:

1. Position the computer upright, with the front toward you.

2. Open the computer as far as possible.

3. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the
top edge (3) of the display bezel until the bezel disengages from the display enclosure.
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b. Remove the display bezel (4). The display bezel is available using spare part number
702860-001 on models with a webcam and 702861-001 on models without a webcam.

4. If it is necessary to replace the webcam/microphone module:

a. Detach the webcam/microphone module (1) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided tape.)

b. Disconnect the cable (2) from the webcam/microphone module.

c. Remove webcam/microphone module. The webcam module is available using spare part
number 702854-001. The microphone module is available using spare part number
702873-001.
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5. If it is necessary to replace the display panel:

a. Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the
display enclosure.

● 702871-001 — 35.6-cm (14.0-in), LED, HD, AntiGlare display panel

● 708771-001 — 35.6-cm (14.0-in), LED, HD+, AntiGlare display panel

b. Rotate the top of the display panel downward (1).

c. Lift the tape that secure the display cable connector on the panel (2), and then disconnect the
cable (3) from the connector (4).
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Reverse this procedure to reassemble and install the display assembly components.
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Hard drive cover

NOTE: The hard drive cover is available in the Plastics kit, spare part number 702877-001.

Description Spare part number

Plastics kit 702877-001

Before removing the hard drive cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

Remove the hard drive cover:

1. Loosen the 2 captive hard drive cover screws (1).

2. Slide the hard drive cover away from the computer (2), and then lift the cover off the computer
(3).

Reverse the removal procedures to install the hard drive cover.
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Hard drive/SSD drive

NOTE: The hard drive spare part kit does not include the hard drive bracket, connector, or screws.

The solid-state drive spare part kit includes the Hard Drive Hardware Kit, which includes the bracket,
connector, and screws..

Description Spare part number

Hard drive (does not include hard drive bracket or screws):  

500-GB, 7200-rpm, 7-mm SED 703268-001

500-GB, 7200-rpm, 7-mm 703267-001

320-GB, 7200-rpm, 9.5-mm 603783-001

Solid-state drive (includes bracket, connector, and screws):

256-GB, SATA III, self-encrypting drive (SED) 702865-001

180-GB, SATA III 702864-001

mSATA SSD:

256-GB mSATA 702866-001

32-GB mSATA 702867-001

24-GB mSATA 702868-001

Hard Drive Hardware Kit (includes hard drive bracket, connector, and screws) 702870-001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

Remove the hard drive:

1. Loosen the 4 captive hard drive screws (1) that secure the drive to the computer.

2. Pull the hard drive tab (2) upward to disconnect the hard drive.
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3. Lift the hard drive, and then pull the hard drive out of the hard drive bay.

4. If it is necessary to disassemble the hard drive, perform the following steps:

a. Remove the connector from the hard drive (1).

b. Remove the four Phillips PM3.0×4.0 screws (2) that secure the hard drive bracket to the
hard drive.

c. Remove the hard drive bracket (3) from the hard drive. The hard drive bracket, connector,
and screws are available in the Hard Drive Hardware Kit, spare part number 702870-001.

Reverse this procedure to reassemble and install the hard drive.
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mSATA drive

Description Spare part number

256-GB mSATA drive 702866-001

32-GB mSATA drive 702867-001

24-GB mSATA drive 702868-001

Before removing the mSATA drive follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

Remove the mSATA drive:

1. Remove the two Phillips PM2.0×3.0 screws (1) that secure the drive to the system board. (The
drive tilts up.)
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2. Remove the drive (2) by pulling it away from the slot at an angle.

NOTE: mSATA drives are designed with a notch to prevent incorrect insertion.

Reverse this procedure to install the mSATA drive.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 702853-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the computer.

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Service cover

Description Spare part number

Service cover 704441001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

Remove the service cover:

1. Loosen the 5 captive Phillips screws (1) that secure the cover to the computer.

2. Tilt the door up from the computer slightly (2), and then lift the cover up and off the computer (3).

Reverse the removal procedures to install the service cover.
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Memory module

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number

8-GB memory module (PC3, 12800, 1600-MHz) 634091-001

4-GB memory module (PC3, 12800, 1600-MHz) 641369-001

2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then
click Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

6. Remove the service cover Service cover on page 53).
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Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

NOTE: The computer uses two memory slots. The top slot houses the expansion memory module
and the bottom slot houses the primary memory module.

Reverse this procedure to install a memory module.
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WWAN module

NOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

HP hs2350 HSPA+ Mobile Broadband Module 668969-001

HP un2430 EV-DO/HSPA Mini Card 702080-001

HP hs2350 hspa+ Mobile Broadband Module 710788-001

HP lt2522 LTE/EV-DO Mobile Broadband Module 710789-001

HP lt2523 LTE/HSPA+ Mobile Broadband Module 710790-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

6. Remove the service cover (see Service cover on page 53).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WWAN module to the
system board. (The WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch to prevent incorrect insertion.

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

Intel Centrino Advanced-N 6235 670292-001

Intel Centrino Advanced-N 6205 WLAN module 631954-001

QC/Atheros AR9462 802.11a/b/g/n 2x2 BT4.0 combo 676786-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

6. Remove the service cover (see Service cover on page 53).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WLAN antenna cable connects to the middle terminal on the WLAN module.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board.
(The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.

Component replacement procedures 59



Keyboard

Description Spare part number

Keyboard 684252-xx1

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the hard drive cover (see Hard drive cover on page 47).

6. Remove the service cover (see Service cover on page 53).

Remove the keyboard:

1. Loosen the 4 captive Phillips screws that secure the keyboard to the computer.

2. Rest and secure the computer on its right side.

3. Partially open the computer.
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4. Insert a screw driver or similar thin tool into the keyboard release opening near the fan, and then
press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.

6. Lift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until it
rests upside down on the palm rest (3).

7. Release and disconnect the following connectors and cables:

● Release the pointing stick connector (1) and remove the cable (2).

● Release the large keyboard connector (3) and remove the cable (4).

● Release the small keyboard connector (5) and remove the cable (6).
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8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Base enclosure

Description Spare part number

Base enclosure 702863-001

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. Keyboard (see Keyboard on page 60)

Remove the base enclosure:

1. Close the computer and position it upside down.

2. Remove the WLAN (1) and WWAN (2) antennas from the routing path (3) in the base enclosure.
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3. Remove the 13 Torx PM2.0×5.0 screws that secure the base enclosure to the computer.

4. Remove the 7 Torx PM2.0×3.0 screws from the battery bay that secure the base enclosure to
the computer.
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5. Lift the base enclosure (1) off the computer while threading the antenna cables through the hole in
the base enclosure (2).

Reverse this procedure to install the base enclosure.

Touchpad

Before removing the touchpad, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. Keyboard (see Keyboard on page 60)

e. Base enclosure (see Base enclosure on page 63)

Remove the touchpad:

1. Remove the 2 Phillips PM2.0×3.0 screws (1) that secure the touchpad to the computer.
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2. Lift the touchpad from the computer (2).

3. Remove the touchpad.

Reverse this procedure to install the touchpad.

NOTE: When replacing the touchpad, make sure to install the screws into holes closer to the edge of
computer.

Power connector

Description Spare part number

Power connector 702875-001

Before removing the power connector, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)
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d. Keyboard (see Keyboard on page 60)

e. Base enclosure (see Base enclosure on page 63)

Remove the power connector:

1. Position the base enclosure with the front toward you.

2. Disconnect the power connector cable from the system board (1).

3. Lift the power connector from the computer (2).

4. Remove the power connector.

Reverse this procedure to install the power connector.
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Fan

Description Spare part number

Fan (includes cable) 702859-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. Keyboard (see Keyboard on page 60)

e. Base enclosure (see Base enclosure on page 63)

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Loosen the 2 captive Phillips screws (2) that secure the fan to the top cover.

3. Remove the fan (3).

Reverse this procedure to install the fan.
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System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

System boards for use in models without Windows 8:  

Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB cache) 702848-001

Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB cache) 702849-001

Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB cache) 704439-001

Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) 702847-001

System boards for use in Windows 8 models:  

Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB cache) for use in
models with Windows 8 Standard

702848-501

Intel Core i7-3667U processor (2.00 GHz [3.2-GHz max turbo frequency], 4-MB cache) for use in
models with Windows 8 Professional

702848-601

Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB cache) for use in
models with Windows 8 Standard

702849-501

Intel Core i5-3427U processor (1.80 GHz [2.8-GHz max turbo frequency], 3-MB cache) for use in
models with Windows 8 Professional

702849-601

Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB cache) for use in
models with Windows 8 Standard

704439-501

Intel Core i5-3317U processor (1.70 GHz [2.6-GHz max turbo frequency], 3-MB cache) for use in
models with Windows 8 Professional

704439-601

Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) for use in models with Windows 8
Standard

702847-501

Intel Core i3-3217U processor (1.80 GHz, 3-MB cache) for use in models with Windows 8
Professional

702847-601

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)
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d. Fan (see Fan on page 68)

e. Keyboard (see Keyboard on page 60)

f. Base enclosure (see Base enclosure on page 63)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● SIM (see SIM on page 42, if applicable)

● Memory module (see Memory module on page 54)

● WWAN module (see WWAN module on page 56)

● WLAN module (see WLAN module on page 58)

● Heat sink (see Heat sink on page 72)

Remove the system board:

1. Disconnect the following cables:

● (1): Right speaker cable

● (2): Display panel

● (3): Left speaker cable

● (4): Touchpad

● (5): Smart card reader
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2. Remove the 2 Phillips PM2.0×4.0 screws that secure the system board to the computer.

3. Lift the left side of the system board up at an angle (1).

4. Pull the system board away from and out of the computer (2), making sure the connectors on the
right side of the board (3) are clear of the computer.

NOTE: To avoid breaking the board, support the right side of the system board near the heat
sink (3) as you lift it up and out of the computer.

Reverse this procedure to install the system board.
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Heat sink

NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

Heat sink 707907-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. WLAN module (see WLAN module on page 58)

e. WWAN module (see WWAN module on page 56)

f. Fan (see Fan on page 68)

g. Keyboard (see Keyboard on page 60)

h. Base enclosure (see Base enclosure on page 63)

i. System board (see System board on page 69)

Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.
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2. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink, processor, and system board spare part kits.

The following illustration shows the replacement thermal material locations. Thermal paste is used
on the heat sink (1) and the processor (2).

Reverse this procedure to install the heat sink.
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Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 702869-001

Before removing the speaker assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. Keyboard (see Keyboard on page 60)

e. Base enclosure (see Base enclosure on page 63)

f. Fan (see Fan on page 68)

g. System board (see System board on page 69)

Remove the speaker assembly:

1. Remove the 2 Phillips PM2.0×3.0 screws (1) that secure each speaker to the computer.

74 Chapter 4   Removal and replacement procedures



2. Remove the speakers (2) from the computer.

Reverse this procedure to install the speakers.

Smart card board

Description Spare part number

Smart card board (includes cable) 702844-001

Before removing the smart card reader, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41).

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. Keyboard (see Keyboard on page 60)

e. Base enclosure (see Base enclosure on page 63)

f. Fan (see Fan on page 68)

g. System board (see System board on page 69)
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Remove the smart card board:

1. Remove the Phillips PM2.0×2.5 broadhead screw (1) that secures the board to the computer.

2. Rotate the board upward (2) at an angle, and then remove it from the computer (3).

Reverse the removal procedures to install the smart card board.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes cable) 702845-001

Before removing the fingerprint reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. Keyboard (see Keyboard on page 60)

e. Base enclosure (see Base enclosure on page 63)

f. Fan (see Fan on page 68)

g. System board (see System board on page 69)

Remove the fingerprint reader board:

1. Position the system board upside down.

2. Disconnect the fingerprint reader board cable from the system board connector, and then remove
the assembly.

3. Remove the fingerprint reader board and cable.

Reverse this procedure to install the fingerprint reader board.
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Display assembly

This section describes removing components that require you to completely remove the display panel.
For more information about removing display components that do not require that you remove the
assembly from the computer, see Display assembly components (panel, bezel, webcam, microphone)
on page 43.

NOTE: The display assembly is spared at the subcomponent level only.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Hard drive cover (see Hard drive cover on page 47)

b. Hard drive (see Hard drive/SSD drive on page 48)

c. Service cover (see Service cover on page 53)

d. WLAN module (see WLAN module on page 58)

e. WWAN module (see WWAN module on page 56)

f. Fan (see Fan on page 68)

g. Keyboard (see Keyboard on page 60)

h. Base enclosure (see Base enclosure on page 63)

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.
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2. Release the display panel cable from the routing channel (2).

3. Open the computer and position it with the base enclosure on a table and the display hanging
down.

NOTE: Be sure to support the display when removing the screws.

4. Remove the four Phillips PM2.5×4.0 screws (1) that secure the display assembly to the computer.

5. Remove the display assembly from the top cover (2).
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6. To remove the display bezel:

a. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the
top edge (3) of the display bezel until the bezel disengages from the display enclosure.

b. Remove the display bezel (4). The display bezel is available using spare part number
702860-001 on models with a webcam and 702861-001 on models without a webcam.

NOTE: For this procedure the display will not be connected to the computer as shown in
the following image.

7. To remove the display panel:

NOTE: For this procedure the display will not be connected to the computer as shown in the
following images.

a. Remove the four Phillips PM2.0×3.0 screws that secure the display panel to the
display enclosure.

Display panels are available using the following spare part numbers:

● 702871-001 — 35.6-cm (14.0-in), LED, HD, AntiGlare display panel

● 708771-001 — 35.6-cm (14.0-in), LED, HD+, AntiGlare display panel
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b. Rotate the top of the display panel downward (1).

c. Lift the tape that secure the display cable connector on the panel (2), and then disconnect the
cable (3) from the connector (4).

NOTE: For this procedure the display will not be connected to the computer as shown in
the following image.
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8. If it is necessary to replace the display hinges:

Display hinge covers and hinges are available in the Display Hinge Kit, spare part number
702857-001.

a. Remove the Phillips broadhead PM2.0×2.5 screw (1) that secures each hinge cover to the
display enclosure.

b. Remove the display hinge covers (2) from atop the hinges.

c. Remove the 2 broadhead Phillips PM2.0×2.5 screws (1) that secure each display hinge to
the display enclosure.
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d. Lift the display hinges off the display enclosure (2).

9. If it is necessary to replace the WLAN antenna cables and transceivers:

WLAN and WWAN antennas are available in the Antenna Kit, spare part number 702876-001.

a. Release the WLAN antenna transceivers (1) from the clips built into the display enclosure.
(The WLAN antenna transceivers are attached to the display enclosure with double-
sided tape.)

b. Detach the WLAN antenna cables from the routing channels (2) built into the display
enclosure.

Component replacement procedures 83



c. Remove the WLAN antenna cables and transceivers. The WLAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 702876-001.

10. If it is necessary to replace the WWAN antenna cables and transceivers:

WLAN and WWAN antennas are available in the Antenna Kit, spare part number 702876-001.

a. Release the WWAN antenna transceivers (1) from the clips built into the display enclosure.
(The WWAN antenna transceivers are attached to the display enclosure with double-
sided tape.)

b. Detach the WWAN antenna cables from the routing channels (2) built into the display
enclosure.

c. Remove the WWAN antenna cables and transceivers. The WWAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 702876-001.
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Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Windows 7 – Computer Setup (BIOS) and Advanced
System Diagnostics

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.
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4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type help and then select Help and Support.

2. In the Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type explorer, and then select File Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a replacement
battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main
menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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Windows 8 – Computer Setup (BIOS) and Advanced
System Diagnostics

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type help and then select Help and Support.

2. In the Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type explorer, and then select File Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a replacement
battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main
menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.

SUSE Linux – Computer Setup (BIOS) and Advanced
System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
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Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.
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Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

SUSE Linux – Computer Setup (BIOS) and Advanced System Diagnostics 99

http://www.hp.com/go/contactHP
http://welcome.hp.com/country/us/en/wwcontact_us.html


6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 33.80 cm 13.3 in

Depth 23.13 cm 9.09 in

Height (front to back) 1.95 cm 0.77 in

Weight

Equipped with one memory module, WLAN module, and
mSATA drive

1.63 kg 3.6 lbs

Input power

Operating voltage and current 18.5 V dc @ 3.5 A - 65 W

– or –

19.0 V dc @ 4.74 A - 90 W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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35.6-cm (14.0-in) display specifications

 Metric U.S.

Dimensions

Height 17.6 cm 6.93 in

Width 31.2 cm 12.28 in

Diagonal 35.7 cm 14.06 in

Number of colors up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format HD, SVA (1366 x 768)

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 3.46 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 500-GB* 320-GB*

Dimensions

Height 7 mm 7 mm

Length 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm

Weight 110 g 110 g

Interface type SATA SATA

Transfer rate

Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec

Security ATA security or SED ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 1.5 ms

Average (read/write) 11/13 ms 11/13 ms

Maximum 22 ms 22 ms

Logical blocks 976,773,168 628,142,448

Disk rotational speed 7200 rpm 7200 rpm

Operating temperature  

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Solid-state drive specifications

 180-GB* 256-GB*

Dimensions

Height 7 mm 7 mm

Length 100.5 mm 100.5 mm

Width 69.9 mm 69.9 mm

Weight 78 g 78 g

Interface type ATA-7 ATA-7

Transfer rate

Sequential Read

Random Read

Up to 550 MB/s

Up to 50K IOPS

Up to 460 MB/s

Up to 46K IOPS

Sequential Write

Random Write

Up to 520 MB/s

Up to 80K IOPS

Up to 260 MB/s

Up to 56K IOPS

Ready time, Maximum (to not busy) 2.0 s 4.0 s

Access times

Logical 0.1 ms 0.1

Total logical sectors 351,651,888 500,118,192

Operating temperature

Operating

Non-operating

0° to 70°C (32°F to
158°F)

-55° to 95°C (-67°F to
203°F)

0° to 70°C (32°F to
158°F)

-40° to 80°C (-40°F to
176°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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mSATA drive specifications

 24-GB* 32-GB* 256-GB*

Dimensions

Height 1 mm 1 mm 1 mm

Length 50.8 mm 50.8 mm 50.8 mm

Width 28.9 mm 28.9 mm 28.9 mm

Weight < 10 g < 10 g < 10 g

Interface type ATA-7 ATA-7 ATA-7

Transfer rate

Sequential Read

Random Read

Up to 160 MB/s

Up to 128 MB/s

Up to 380 MB/s

Up to 180 MB/s

Up to 490 MB/s

Up to 480 MB/s

Sequential Write

Random Write

Up to 115 MB/s

Up to 16 MB/s

Up to 80 MB/s

Up to 40 MB/s

Up to 250 MB/s

Up to 100 MB/s

Ready time, Maximum (to not busy) 2.0 s 4.0 s 4.0 s

Access times

Logical 0.1 ms 0.1 ms 0.1

Total logical sectors 46,905,264 62,533,296 500,118,192

Operating temperature

Operating

Non-operating

0° to 70°C (32°F to
158°F)

-55° to 95°C (-67°F
to 203°F)

0° to 70°C (32°F to
158°F)

-40° to 80°C (-40°F
to 176°F)

0° to 70°C (32°F to
158°F)

-40° to 80°C (-40°F
to 176°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Windows 7 – Backup and recovery
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
an optional external optical drive, or create system restore points. In case of system failure, you can use
the backup files to restore the contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.

Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media performs a system recovery if the hard drive becomes corrupted. A
system recovery reinstalls the original operating system and the software programs installed at the
factory, and then configures the settings for the programs.
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HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications. Choosing
this selection creates a DVD that restores the original operating system and the software programs
installed at the factory.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

NOTE: Operating system recovery media can be created only once. Thereafter, the option to create
that media will not be available.

1. Select Start > All Programs > Security and Protection > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after software
setup, you should create system repair discs (select models only) using HP Recovery Disc Creator using
the installed optical drive (select models only) or an optional external optical drive and back up your
system. As you add new software and data files, you should continue to back up your system on a
regular basis to maintain a reasonably current backup. The system repair discs (select models only) are
used to start up (boot) the computer and repair the operating system in case of system instability or
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure
occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

Windows 7 – Backup and recovery 107



NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see Using a Windows
7 operating system DVD (purchased separately) on page 110.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:

108 Chapter 7   Backup and recovery



CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see Using a Windows 7 operating
system DVD (purchased separately) on page 110.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, see Using a Windows 7 operating system DVD
(purchased separately) on page 110.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to http://
www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Windows 8 – Backup and recovery
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive, create system repair media (select models only) by using an optional
external optical drive, or create system restore points. In case of system failure, you can use the backup
files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type help, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.
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NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type help, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. As you add new software and data files, you should continue to back up your system
on a regular basis to maintain a reasonably current backup. The system repair media (select models
only) are used to start up (boot) the computer and repair the operating system in case of system
instability or failure. Your initial and subsequent backups allow you to restore your data and settings if
a failure occurs.

On Start screen, type backup, select Settings, and then select Save backup copies of your files
with File History.

You can back up your information to an optional external hard drive or a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, select Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.
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NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system.

Using the Windows recovery tools

To recover information you previously backed up:

▲ From the Start screen, type help, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. All
files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition.

From the Start screen, type explorer, and then select File Explorer.

– or –

From the Start screen, type computer, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately).

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type help, and then select Help
and Support.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.
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To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type
computer, and then select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using a Windows 7 operating system DVD
(purchased separately) on page 110.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.
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IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type help, and then select Help and Support.

NOTE: You may be prompted for your permission or password when using Refresh. See Help and
Support for more information. From the Start screen, type help, and then select Help and Support.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.
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3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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SUSE Linux – Backup and recovery
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if
ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see
Performing a system recovery on page 117.

2. As you add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
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4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVD±RW optical drive.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All
files you have created and any software installed on the computer are permanently removed. The
recovery tool reinstalls the original operating system and HP programs and drivers that were installed at
the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal
files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system
failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the
right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-
Restore?

6. Follow the on-screen instructions.

USB Recovery option

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the SLED
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore
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the system to the original factory state when the F11 recovery option is not available. This process
should be done on first obtaining the computer.

CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or
on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The
Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

2. Select Computer > More applications > Tools > Create Recovery USB.

3. Enter the root password when prompted.

4. Select USB Disk On Key from the list.

5. Click OK.

6. A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

7. The backup process will display a status dialog box while the backup is in progress.

NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the
key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered
has been backed up. The recovery process destroys all data on the system to be recovered.

1. Turn off the computer.

2. Connect the USB Disk On Key to a USB port on the computer.

3. Turn on the computer while holding down the f9 key.

4. Once the system has booted, the Boot Options menu should appear.

5. Using the arrow keys, select USB Disk On Key and press enter.

NOTE: The description may vary from one USB key to another. Any entry other than Optical
Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On
Key will boot.

7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and select
No. The system will reboot. Back up the system data and repeat the previous steps. If no data
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should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux operating
system.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and preserves
user data.

● Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in
industry-standards based HP Business Notebook PC systems and provide general instructions for
restoring nonvolatile memory that can contain personal data after the system has been powered off and
the hard drive has been removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain
volatile DDR memory. The amount of nonvolatile memory present in the system depends upon the
system configuration. Intel-based and AMD-based system boards contain nonvolatile memory
subcomponents as originally shipped from HP assuming that no subsequent modifications have been
made to the system and assuming that no applications, features, or functionality have been added to or
installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC
system, personal data can remain on volatile system memory (DIMMs) for a finite period of time and
will also remain in nonvolatile memory. The steps below will remove personal data from the notebook
PC, including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of
these steps are disclosed in the Maintenance & Service Guides available for HP PC products available
on the product support pages at www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal
data. Restoring or re-programming nonvolatile memory that does not store personal data is neither
necessary nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near
the bottom of the display, or press the ESC key to display the start up menu, then press F10 .
If the system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities
menu. Select System IDs, and then select the tag that has been set. Press the spacebar
once to clear the tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then
select DriveLock password. Select the desired hard drive. Click Disable protection,
enter the existing master DriveLock password, then press Enter to confirm and return to the
prior menu. Repeat this procedure if more than one hard drive has a DriveLock password.
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f. If an Automatic DriveLock password is set, select the Security menu, scroll down to
Automatic DriveLock, then select the desired hard drive and disable protection. Repeat
this procedure if more than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the
warning message.

h. Select the File menu, then Save Changes and Exit.

i. Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint
sensor, one or two prompts will appear. One to clear the TPM and the other to Reset
Fingerprint Sensor; press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel® Centrino with
VProTM, reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select
System Configuration, then AMT Options. Then select Un-configure AMT on next
boot. Select Save then Yes. Select the File menu, and then select Save Changes and
Exit. Reboot the system and confirm that you want to un-configure AMT.

j. If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to de-
activate it.

k. If the optional Absolute® Software Computrace® management and tracking service was
activated on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application
that, ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10
when prompted near the bottom of the display, or press ESC to display the start up menu,
then press F10. Select the Security menu and scroll down to the Utilities menu. Select
Disk Sanitizer and select the desired drive. For a higher level of protection, select
Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard
drive capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a
third party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup
by powering on the system and pressing F10 when prompted near the bottom of the display.
Select the Security menu and scroll down to the Utilities menu. Select Secure Erase and
select the desired hard drive.
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Non-volatile memory usage

Non Volatile
Memory Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain
data when
power is
removed?

What is the
purpose of
this
memory?

How is data input into
this memory?

How is this memory
write protected?

Real Time Clock
(RTC) battery
backed-up
CMOS
configuration
memory (CMOS)

256 Bytes No Yes Stores system
date and time
and limited
keyboard
controller data.

Using the F10 Setup utility
or changing the Microsoft®
Windows® date & time.

This memory is not write-
protected. HP
recommends password
protecting the F10 Setup
utility.

Controller (NIC)
EEPROM

64 Kbytes
(not customer
accessible)

No Yes Store NIC
configuration
and NIC
firmware.

Using a utility from the NIC
vendor that can be run from
DOS.

A utility is required to
write data to this
memory and is available
from NIC vendor.
Writing data to this
ROM in an
inappropriate manner
will render the NIC non-
functional.

Keyboard ROM 64 Kbytes
(not customer
accessible)

No Yes Stores
firmware code
(keyboard,
mouse, &
battery
management).

Programmed at the factory.
Code is updated when the
system BIOS is updated.

A utility is required for
writing data to this
memory and is available
on the HP website.
Writing data to this
ROM in an
inappropriate manner
can render the PC non-
functional.

DIMM Serial
Presence Detect
(SPD)
configuration
data

256 Bytes
per memory
module, 128
Bytes
programmabl
e (not
customer
accessible)

No Yes Stores memory
module
information.

Programmed by the memory
vendor.

Data cannot be written
to this memory when the
module is installed in a
PC. The specific write
protection method varies
by memory vendor.

System BIOS 4 to 5
MBytes

Yes Yes Store system
BIOS code and
PC
configuration
data.

System BIOS code is
programmed at the factory.
Code is updated when the
system BIOS is updated.
Configuration data and
settings are input using the
F10 setup utility or a custom
utility.

A utility is required for
writing data to this
memory and is available
on the HP website.
Writing data to this
ROM in an
inappropriate manner
can render the PC non-
functional.
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Non Volatile
Memory Type

Amount
(Size)

Does this
memory
store
customer
data?

Does this
memory
retain
data when
power is
removed?

What is the
purpose of
this
memory?

How is data input into
this memory?

How is this memory
write protected?

Intel
Management
Engine Firmware
(present only in
models ending in
a ‘p’,‘w’, or ‘m’
or with Intel
Centrino Pro
technology)

1.5 or
5MByte

Yes Yes Stores
Management
Engine Code,
Settings,
Provisioning
Data and iAMT
third party
data store.

Management Engine Code
is programmed at the
factory. Code is updated via
Intel secure firmware update
utility. Unique Provisioning
Data can be entered at the
factory or by an
administrator using the
Management Engine (MEBx)
setup utility. The third party
data store contents can
populated by a remote
management console or
local applications registered
by an administrator to have
access to the space.

The Intel chipset is
configured to enforce
HW protection to block
all direct read/write
access to this area. An
Intel utility is required for
updating the firmware.
Only firmware updates
digitally signed by Intel
can be applied using
this utility.

Bluetooth flash 2Mbit No Yes Stores
Bluetooth
configuration
and firmware.

Programmed at the factory.
Tools for writing data to this
memory are not publicly
available but can be
obtained from the silicon
vendor.

A utility is required for
writing data to this
memory and is made
available through newer
versions of the driver if
the flash requires an
upgrade.

802.11 WLAN
EEPROM

4kb to 8kb No Yes Stores
configuration
and calibration
data.

Programmed at the factory.
Tools for writing data to this
memory are not made
public.

A utility is required for
writing data to this
memory and is typically
not made available to
the public unless a
firmware upgrade is
necessary to address a
unique issue.

Web Camera 64K bit No Yes Store Web
Cam
configuration
and firmware.

Using a utility from the
device manufacturer that
can be run from Windows.

A utility is required for
writing data to this
memory and is typically
not made available to
the public unless a
firmware upgrade is
necessary to address a
unique issue.

Fingerprint
Reader

512kByte
Flash

Yes Yes Stores
fingerprint
templates.

By enrolling in HP
ProtectTools Security
Manager.

Only a digitally signed
application can make
the call to write to the
flash.
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Questions and answers
1. How can the BIOS settings be restored (returned to factory settings)?

a. Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b. Select File, then select Restore defaults.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. What kind of configuration data is stored on the DIMM Serial Presence Detect
(SPD) memory module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial
number, data width, speed/timing, voltage and thermal information. This information is written by
the module manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the
memory module is installed in a PC. Third party tools do exist that can write to the EEPROM when
the memory module is not installed in a PC. There are various third party tools available to read
SPD memory.

3. Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip
writable, and if so how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform
the write function.

4. In some PC systems, the Firmware Hub for System BIOS is a flash memory chip
so that updates can be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.

5. What is meant by “Restore the nonvolatile memory found in Intel-based system
boards”?

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration
data.

6. Does resetting the CMOS configuration memory return the PC back to factory
defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not
reset many of the system data and configuration defaults to their factory settings. To return these
system data and configuration defaults to factory settings, refer to question and answer 1 and
follow the instructions for returning the BIOS settings to factory defaults.

124 Chapter 8   Statement of Volatility



9 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at http://
www.hp.com/recycle.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the LCD panel and the backlight. When you remove
these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).
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NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.

Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Position the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Position the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Position the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part numbers

30, 32
advanced system diagnostics 91,

96
antenna

removal 83, 84
spare part number 28, 34,

84
Antenna Kit, spare part number

28, 34
audio, product description 2
audio-in (microphone) jack,

identifying 17
audio-out (headphone) jack,

identifying 17

B
Backup and Restore 107, 111
base enclosure

removal 63
spare part number 25, 34, 63

battery
identifying 20
removal 41
spare part numbers 26, 32,

41
battery light 16
battery release latch 20
BIOS

determining version 89, 94,
99

downloading an update 90,
95, 99

updating 89, 94, 98
Blu-ray R/RE DVD±RW SuperMulti

DL Drive
precautions 37

Blu-ray ROM DVD±RW SuperMulti
DL Drive

precautions 37
buttons

left pointing stick 10
left TouchPad 10
power 13
right pointing stick 10
right TouchPad 10
volume mute 13
wireless 13

C
cables, service considerations 36
caps lock light, identifying 11
chipset, product description 1
components

bottom 19
display 8
front 16
left side 17
right side 18
top 9

computer major components 23
computer reset 119
Computer Setup

navigating and selecting 87,
92, 97

restoring factory settings 87,
93, 98

computer setup
navigating and selecting 97
restoring factory settings 98

computer specifications 101
connector, power 17
connectors, service

considerations 36

D
display

specifications 102
display assembly

removal 78
subcomponents 27

display assembly components
removal 43
spare part numbers 43

display bezel
removal 43, 80
spare part numbers 28, 34,

43, 44, 80
display component recycling 127
display enclosure, spare part

numbers 28, 34
display hinge

removal 82
spare part number 28, 34

display hinge cover
removal 82

Display Hinge Kit, spare part
number 28, 34

display panel
product description 1
removal 45, 80
spare part number 43
spare part numbers 28, 34,

35, 45, 80
Display Panel Support Kit, spare

part numbers 28, 32
DisplayPort, identifying 18
docking connector, identifying 18
drives, preventing damage 37
DVD-ROM Drive

precautions 37
DVD±RW Double-Layer with

SuperMulti Drive
precautions 37
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E
electrostatic discharge 37
embedded numeric keypad,

identifying 14, 15
equipment guidelines 40
esc key, identifying 14
Ethernet, product description 3
external monitor port 18

F
f11 recovery 109, 112
fan

removal 68
spare part number 24, 34, 68

fingerprint reader board
removal 77
spare part number 25, 33, 77

fingerprint reader, identifying 13
flash cache, product description 2
fn key, identifying 14, 15
function keys, identifying 14, 15

G
graphics, product description 1
grounding guidelines 37
guidelines

equipment 40
grounding 37
packaging 39
transporting 39
workstation 39

H
Hard drive

spare part numbers 48
hard drive

precautions 37
product description 2
removal 48
spare part numbers 26, 29,

31, 35, 48
specifications 103

hard drive bracket
removal 49

hard drive cover
removal 47
spare part number 47

hard drive cover, illustrated 25
Hard Drive Hardware Kit

spare part number 26, 29,
34, 48

hard drive light 16
hard drive recovery 109, 112
hard drive, identifying 19
headphone (audio-out) jack 17
heat sink

removal 72
spare part numbers 25, 35,

72

I
integrated webcam light,

identifying 8
internal display switch 9
internal microphones, identifying

8

J
jacks

audio-in (microphone) 17
audio-out (headphone) 17
network 18
RJ-45 (network) 18

K
keyboard

product description 4
remval 60
spare part numbers 24, 32,

33, 60
keypad

embedded numeric 14, 15
keys

esc 14
fn 14, 15
function 14, 15
Windows applications 14
Windows logo 14

L
latch, battery release 20
legacy support, USB 86, 92, 97
lights

battery 16
caps lock 11
hard drive 16
num lock 11
power 11, 16
TouchPad 11
webcam 8
wireless 11, 16

M
mass storage device

illustrated 29
precautions 37
spare part numbers 29

Media Card Reader, identifying
18

memory module
product description 2
removal 54
spare part numbers 31, 54

microphone
product description 2

microphone (audio-in) jack,
identifying 17

microphone module
removal 44
spare part number 28, 34,

43, 44
model name 1
mouse, spare part numbers 30,

31, 32
mSATA drive

removal 50
spare part numbers 34, 48,

50
specifications 105

mSATA module
product description 2

N
network jack, identifying 18
num lock light 11

O
operating system, product

description 5
optical drive

precautions 37

P
packaging guidelines 39
PCID label 22
plastic parts, service

considerations 36
Plastics Kit

spare part numbers 34
pointing device, product

description 4
pointing stick 10
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ports
DisplayPort 18
external monitor 18
product description 4
USB charging 17

power button, identifying 13
power connector

removal 66
spare part number 66

power connector, identifying 17
power connector, spare part

number 66
power cord

set requirements 125
spare part numbers 30, 31

power lights 11, 16
power requirements, product

description 4
processor

product description 1
product description

audio 2
chipset 1
display panel 1
Ethernet 3
external media cards 3
flash cache 2
graphics 1
hard drive 2
keyboard 4
memory module 2
microphone 2
mSATA module 2
operating system 5
pointing device 4
ports 4
power requirements 4
processors 1
product name 1
security 4
serviceability 7
solid-state drive 2
video 2
wireless 3

product name 1

R
recovery partition 109, 112
recycle

computer 119

reinstall Windows 114
removal/replacement

preliminaries 36
procedures 41

remove everything and reinstall
Windows 119

reset
computer 119
steps 119

restoring the hard drive 109, 112
RJ-45 (network) jack, identifying

18
RTC battery

removal 52
spare part number 25, 34, 52

S
Screw Kit, spare part number 30,

33
SD card insert, illustrated 25
security cable slot, identifying 17
security, product description 4
service considerations

cables 36
connectors 36
plastic parts 36

service cover
removal 53
spare part number 25, 35, 53

service tag 21
serviceability, product description

7
setup utility

navigating and selecting 87,
92

restoring factory settings 87,
93

SIM slot, identifying 20
SIM, removal 42
slots

security cable 17
SIM 20
smart card 17

smart card board
removal 75
spare part number 75

Smart Card reader
spare part number 24, 33

smart card slot 17

solid-state drive
precautions 37
product description 2
spare part numbers 26, 29,

34, 48
specifications 104

speaker assembly
removal 74
spare part number 24, 34, 74

speakers, identifying 19
specifications

computer 101
display 102
hard drive 103
mSATA drive 105
solid-state drive 104

system board
removal 69
spare part numbers 24, 69

system repair disc 106
system restore points 106

T
tools required 36
top cover, spare part numbers

24, 34
TouchPad

buttons 10
touchpad

removal 65
TouchPad light, identifying 11
TouchPad zone

identifying 10
touchpad, spare part numbers 34
transporting guidelines 39
travel battery connector,

identifying 19

U
USB 3.0 port 17, 18
USB legacy support 86, 92, 97
USB ports, identifying 17, 18

V
vents, identifying 17, 19
video, product description 2
volume mute button, identifying

13
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W
webcam

spare part number 43
webcam light, identifying 8
webcam, identifying 9
webcam/microphone module

removal 44
spare part number 28, 34

Windows
reinstall 119
remove everything and reinstall

option 119
reset 119

Windows 7 operating system
DVD 110

Windows 8 operating system
DVD 113

Windows applications key,
identifying 14

Windows Backup and Restore
106

Windows logo key, identifying
14

Windows Refresh, using 113
wireless and memory module

compartment
identifying 19

wireless antenna
removal 83, 84
spare part number 28, 34,

84
Wireless Antenna Kit, spare part

number 84
wireless antennas, identifying 8
wireless button, identifying 13
wireless light 11, 16
wireless, product description 3
WLAN antennas, identifying 8
WLAN module

removal 58
spare part numbers 25, 31,

32, 58
workstation guidelines 39
WWAN antennas, identifying 8
WWAN module

removal 56
spare part numbers 25, 31,

32, 56
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